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Introduction

In this document, Paper Prototype Testing with Morae, walk through howtouse Tec hSmi t hés Mor ae
conduct a usability test with a paper prototype.

This document is intended for people that are already familiar with the concept of usability testing.

Usability Testing Basics

I f youdre new t o usushhilityiTésting Bass whichgexplaisstthee basics wfiusabhility
testing, including information about how to figure out what to test, when to test, and how to test. Usability
Testing Basics is available on the Morae Resource CD and in the Morae Learning Center
(http://www.techsmith.com/learn/morae/default.asp).
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Paper Prototype Testing with Morae

Morae is the premier software for deeply wunderstanding
clearly and powerfully. From usability testing to focus groups and beyond, Morae helps you transform designs
and marketing to make things people love.

For a paper prototype test, Morae can record from one or two cameras. With two cameras, you can record
close-up video of the prototype, along with camera video of the user.

We will walk you through completing a test with Morae, including:

P Set Up the Test

# Record and Log Test Sessions

# Analyze and Present Findings

# How to Retrieve Your Key Measures from Morae

The document also contains the following appendices:

B Appendix A: User Research Request
# Appendix B: Test Protocol Document
# Appendix C: Example Usability Test Report
#  Appendix D: Usability Test Checklist

Paper Prototype Testing Considerations

Using paper mock ups, sketches, or wire frames of a system, participants are asked to explain how they
would accomplish real-world tasks using prototype. This method is best used early in the design process to
explore the effectiveness @fconceptual model, navigation, workflow, and othegh-level aspects of the desigmd
to provide design direction.

Because the paper pr ot orteyagtiens with itlwith ihwéll beprecorded usingpaaanterd,s i
consider what cameras, lighting, camera locations, and mounting hardware will be needed to record the
activity.

Because screen recording data will not be available, prepare your markers carefully to ensure that observers
or the person logging on the recording computer will note events such as:

B Task start and end times

The actions the participant takes (buttons clicked, menu items chosen)
When a mistake or error is made

Comments and quotes of the participants

¥y ¥ ¥V ¥

Observations of facial expressions and body language, etc.

Interaction with the participant during a paper-prototype test will need to be high-level, as the interaction of the
prototype will need to be described to the participant by the facilitator. Because of this, paper prototype tests
should be conducted face-to-face (not remotely).

Procedure

The facilitator, or an assistant, acts as the Acomput el
the interactions of the system if it were fully functional when the participant performs an action.
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The person acting as the computer should think of themselves as a machine that can only react to human

actions or input, process information, and produce corresponding output. This means that the facilitator of the

tests must elicit active responses from the participant
participant may want to say, fil would go hereo and it |
participant would click on (by asking non-leading question according to the best practices of any usability test).

In this type of testing, the paper prototype and the p.

camera. A second cameracanalsobeused t o record participant6s-infPectore wi t h
mode.

Use the default configuration provided for paper prototype testing in Morae to record the test. Because there
will be no screen recording used, the recording computer can also be used to log test data during the test by
the facilitator or an assistant; consider having the facilitator log the test on the recording computer. Remember
you may need to flip your camera while recording to make the prototype view properly in the recording.

= Cover your paper prototype with protective plastic and bring dry-erase markers. If your participant
doesndt see something they nee dhagerhimtoraherdravoor writetore r| or i
the prototype. This can be recorded by the camera (you may want to take a close-up shot of the
prototype with drawing on it) and the markings wiped-off for the next participant.

Snyder, C. (2003). Paper Prototyping. San Francisco, California, USA: Morgan Kaufmann.
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Set Up the Test

After you figure out what to test and the goals for testing, use the steps in this section to set up the test in
Morae Recorder. For more information on usability test planning, see Usability Testing Basics, available on
the Morae Resource CD and in the Morae Learning Center.

Morae
Recorder

1. Create a Study Configuration
2. Define the Scenario

. Define Tasks

. Define Markers

. Define Surveys

. Save Study Details

. Configure Recording Details
. Complete Test Set Up

To set up a test in Recorder:

N O |Jo | W

A’ This document walks through this process at a high level. You can find more information on the full
procedures and options in the help included in the Morae components or find both video and written
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.

1. Create a Study Configuration

A study is a group of test sessions where participants complete the same tasks. In Morae, a study
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and
surveys.

You use the same study configuration to record each of the test sessions. Only recordings with the same
study configuration can be later searched and graphed together in Morae Manager.

Morae Recorder includes template study configurations to help you define study configurations for different
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured
Recording Details which define how to record the session.
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When you open Recorder, create a new study configuration based on Paper Prototype Study. When you
click OK, the template study configuration opens in Recorder.

Welcome to Morae Recorder @

To record, you must create or open a study configuration.
Study configuration

The study configuration defines the markers, tasks, and surveys
for your study.

D (3) Create a new study configuration based on:

I aper Prototype Stud v

Default Study
Focus Group

Hardware or Mabile Device Stud
Paper Prototype Stud )1P

— Software or Web Usability Study
L:; (Olunmoderated Usability Study

2. Define the Scenario

A scenario gives the participant the background to complete the tasks. It tells them why they are doing the
tasks and any introductory information they may need to complete the task.

The scenario should be realistic and allow the participant to relate to the situation. For more on how to create
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning
Center.

For example, to find out how users interact with your company web site, the scenario may be:
You will perform up to 4 different tasks using a paper prototype of a software application.

You have just purchased new software and you want to figure out how to get started. Follow the
instructions for each task and then perform the task as you would if you were actually doing this task
for yourself.

Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations,
and reactions.

Do you have any questions?
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Scenario in Morae Configuration

@ Recorder > Modify Study Details button > Description tab

Enter the scenario into the Study instructions field.

Study Details

Description | Task Definitions | Marker Definitions | Survey Definitions |

Enter a name, description and participant instructions For the study.

Study name: | Paper Prototype Study

Study description: Use to record low fidelity prototypes that can't be
displayed on the computer. You can use up to two
cameras. Point the primary camera at the paper
prototype, and the picture-in-picture camera at the
participant.

=

| Study instructions:  lyau will perform up to 4 different tasks using a paper A
prototype of a software application. =

‘You have just purchased new software and you want
to figure out how to get started. Follow the
instructions for each task and then perform the task as
vou would if you were actually doing this task for
vourself,

Please talk out loud while you work, and keep arunning
dialog of your thoughts, actions, expectations, and

ireactions.
™ - - B -

PR %

Morae Scenario Tips

#  Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test
Protocol Document).

#  To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See
AutoPilot in the Morae Recorder help for more information.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Description >
Study Instructions.
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3. Define Tasks

The tasks should relate to real-life actions that fit the scenario. For more on how to create a scenario, see
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center.

For example, if we use the example scenario of AYou ha
figure out how to get s tpaticipasttb,explaimhisror hérifirst snpressiansdithes s f or |
prototype.

Tasks in Morae Configuration

d Recorder > Modify Study Details button > Task Definitions tab

For each task, enter a name, description, and instructions for the participant.

Study Details

| Description | Task Definitions i-Marker Definitions ilgurvey Definitions |

Define tasks to log during sessions.

Name Description Ir
Taski |Firstimpressionsof theprototype
Task 2 How to backup software D
Task 3 ~ Stuck, how would you find help D
Task 4 SR > !
TaskS [ Tasknames, descriptions, and scores are M

available to the task logger in Recorder or
Observer and in the task information in

Success score
Success score applies to all

Definition Scale 5 Add
Completed with ease 0

Completed with difficulty 1 7 Edit
Failed to complete 2 e —

&  Remove

Success score is a standard metric used to
analyze usability tests. You can create a task
success score graph in Manager to automatically
calculate and visually display the completion rate.

Start Sc

= Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test
Protocol Document) on the Task pages. Each task should be on a separate page so the participant
can only see one task at a time.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks.
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4. Define Markers

After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure
out what kinds of actions you want to define marker for because, by flagging important points during recording,
you can save time when you later analyze the results.

For example, mark:

Participant actions

Participant comments and questions

Participant frustration

Areas where a participant gets stuck

Application or web site design issues

Observations about how the participant performs a task

Interesting comments or actions to include in a highlight video

Moments when participantés access Help, want to

¥ ¥V ¥ ¥ ¥V ¥ ¥ V¥

You can also add notes to provide additional details for each marker. All the markers and notes are
synchronized with the video and saved in the recording of each test session.

Morae also includes the ability to score markers, for example 0 (severe) to 2( minor). Manager can
automatically calculate the average severity of the errors.

Markers in Morae Configuration

&3 Recorder > Modify Study Details button > Marker Definitions tab

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color.
Each study configuration template includes a default set of markers. The Hardware or Mobile Device Study
template includes the following markers:

’ QT Quote/comment A d X - Error

’ ’ O- Observation

H i User needs help

P - Participant prompted 0 V1 Video clip

Use the provided default markers, modify the markers, or create new markers that match the goals of your
study or identify specific things you want observers to watch for during a session.

Morae Marker Tips

B  There is no correct number of markers. The object of logging markers during a test is to make it easier to
analyze the test results.

# If you have specific things you want to look for in a test, create a marker for that action, problem, etc.

B Later when you analyze your sessions in Manager, markers help you sift through data and focus on what
you want to analyze. For example, viewing all the Help requested markers may reveal an error where
people are really struggling.

#  When you are ready to create video clips or a presentation for stakeholders, you save time by quickly
going to the moments during the session that you marked to include in the highlight video.
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For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers.

5. Define Surveys

With surveys, you can collect information directly from the participants.

To collect a participantds survey r espongpeteresponses c an
into the survey, have the participant take the survey on the computer running Recorder, or use the Morae
Add-In for Word to print the surveys for the participant to fill in on paper.

After you import recordings into Manager, you can view and compare responses, create graphs based on the
surveys, and export results, including any freeform answers.

Morae can deliver multiple surveys to participants during a session. For example, before the test, after each
task, and after the test.

The template study configuration includes surveys. Use or edit the surveys provided or create your own
surveys.

Surveys in Morae Configuration

Recorder > Modify Study Details button > Survey Definitions tab

Create and associate surveys with session events, such as the end of a task.

| Description | Task Definktions | Marker Definitions | Survey Defintions

Define surveys for this study. Assodate surveys with session events, such as the end of a task,

Name Associate With o~ Add> N
Task 2 Completion Survey  End of Task 2 g [

Task 3 Completion Survey  End of Task 3 =
Task 4 Completion Survey  End of Task 4
Task S Completion Survey  End of Task S
SUS End of record

Survey Definition

Survey detalls
Survey name: Participant instructions:
Demographic Survey Please answer the following question
Associate with:
Beginning of recording v

Morae includes . Survey quastions
System Usability -

Scale (SUS) standard ® Custom 0

satisfaction questions
that you can use once Quastion Type
per study recording Flease indicate your gander: Select one 5
! Flease indicate your age range: Select ons &
' Flaase rate your experience with the Internet Scale
How many hours & week do you spend on the Internet 28 work? Select (
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Morae Survey Tips

[
[

Associate a survey with the beginning of recording, end of recording, or the end of each task.

By associating a survey kwidioh tao stehsasti oenv eenvte.nt ,
Morae readies the survey associated with the current session event.
Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test

Protocol Document).

The System Usability Scale (SUS) is freely available for use in usability assessment and has been used

for a variety of research projects; the only prerequisite for its use is that any published report must
acknowledge the source of the measure. If you use the SUS, add the following to your report:

ASUS was developed as part
devel opment at Digital

of

t he

Equi pment

Co

usabi l

Ltd.

t

y
Re

en
ad

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys.

6. Save Study Details

La File > Save Study Configuration or click the Save Configuration icon.

Study Details must be the same for all recordings in a study and include the items you have just defined:

g

[
[
[

Study name, description, and instructions
Tasks definitions and instructions

Marker definitions and instructions
Survey definitions and associations

By saving the study configuration, and reusing that configuration, all recordings in a study have the same

configuration and can be imported into the same study in Manager.

7. Configure Recording Details

Recording Details included in Morae study configurations define how to record the session, including the
following:

g

¥V ¥ V¥

File saving and processing options
Video sources

What data to capture

Who logs tasks

How to start and end test recordings
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Recording Details in Morae Configuration

&8 Recorder > Recording Details button

The Recording Details of the template study configuration allow you to immediately conduct a recording.
The Recording Details for the Paper Prototype Study template include:

#  Prompt for file saving details when recording stops

Record from a camera and include a Picture-in-Picture video from a second camera
Log tasks with the computer running Recorder

Start and stop recordings manually with Recorder

Allow Observers

¥y ¥V ¥V V¥

Morae Recording Details Tips

# Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected
sources are correct before recording.

# If you change any Recording Details settings, the rest of the settings update to provide a valid or
recommended configuration, if needed.

# Recording Details are saved as part of the study configuration. While the Study Details must be the same
for all recordings in a study, the Recording Details can vary in each recording.

For more information, in the Morae Recorder Help, see Define Recording Details.

8. Complete Test Set Up

Study configuration is now complete. Here are the final things to do before you start testing.

# Create Test Protocol
# Finalize Morae Recorder Setup

Create Test Protocol

The test protocol is a document of everything needed for a test. There is an example protocol document in
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.

B Test Session Setup Checklist

Release Form

Facilitator Script

Participant Instructions and Surveys
Assemble Participant Paperwork (Optional)
Email Invitations for Observers

¥V ¥V ¥ ¥V V¥
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Test Session Setup Checklist

Verify the test setup is the same at the beginning of each test. A test setup checklist makes it easier to go
from one test to the next as quickly as possible and make sure you do not miss anything.

Make a list of all the things you need to do between tests and include it in test protocol document, such as:

v

Erasing any written items on the prototype.

B Clear the test area of any open documents, written notes, etc.
B Prepare participant forms (release form, surveys, etc.)

B Verify the cameras, camera angles, and lighting.

Release Form

A release form gives permission to record thetest. Mor ae records t he piththei ci pant 6
hardware or mobile device with video and audio.

If permission to record is denied, you may still conduct the test and take notes to use in reporting result, but
you must not record the test session.

If the contents of your test require the participant to keep session and product information confidential, include
a non-disclosure agreement to your form.

The example test protocol includes a sample release form that includes a non-disclosure agreement.

Facilitator Script

The facilitator script helps to explain the test session to the participant. The facilitator reads through the script
at the beginning of each test session to ensure the participant understands what to expect during the test.

Participant Instructions and Surveys

Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the
study configuration in the add-in and drag the study and task instructions along with the surveys into the
protocol.

— R

;lv, eroelad:?ane 'x:‘

g~ |
Morse Project ‘ 1
Example Project v -&owse
Survey

|
|
|

1. Please indicate your gender: ‘
( ) Female
[ )Male

2. Please indicate your age range:

()18-25

{ 2635 i
(13650 (4}
{ )51.85 [
[ )65+ 4 L

3. Please rate your experience with the Internet )
Very New 1 2 3 4 S Very Expenenced Ihi

4. How many hours a week do you spend on the Internet at work?

For more information, click the help button in the Morae Add-In for Word.
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Assemble Participant Paperwork (Optional)
Once you finish the protocol document, you need to assemble any paperwork needed for a test.

If you are printing paperwork, each participant needs a copy of the following:

v

Release form

B  Background questionnaire

B Scenario/session instructions
#  Tasks

For the facilitator, print out a copy of the entire protocol. In addition to the participant items listed above, the
facilitator protocol includes the following:

B+  Title page

Session setup checklist

Participant paperwork coversheet

Facilitator script

Task success paths (the best way or ways to complete a task)

List of debrief questions (follow up questions for the end of the test)

¥ ¥V ¥V ¥V V¥

See the example test protocol in Appendix B: Test Protocol Document for an example of complete protocol.

Email Invitations for Observers

Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people
that observe the test can connect to the session, send an email to each observer with the following
information:

# Name of test

#  Date of test

B  Time of test

# |IP address or name of Recorder computer

= You may also want to include a list of the test tasks and markers to let the observers understand what
they should watch for during the test.

Finalize Morae Recorder Setup

Prior to a Morae test, complete the following tasks:

# Complete the Pre-recording Checklist
P Run aPilot Test before Recording
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Complete the Pre-recording Checklist

The following checklist describes critical points that reduce the technical issues you may encounter and
improve Mo r a evérall performance.

Step

Verify the system
requirements

‘ Description

Verify your system meets the recommended specifications to get the most
efficient performance from Morae. For more information, see Morae System
Requirements in the Morae Recorder Help.

Verify you have
enough hard drive
space

Recording file sizes may be approximately 107 15 MB per minute, but the actual
size varies depending on many factors. You should have extra space available for
the best performance during recording.

As a general rule, maintain 5i 10 GB of extra hard drive space as a buffer beyond
what your Morae recording files use.

A’ We recommend initially saving your recordings to a local hard drive to
eliminate the chance of data loss that can occur when saving over a network
or to an external device. After the file is saved, you can copy the recording file
to an external device.

Test your setup and
scenario

Test your setup before the actual recording session to resolve any possible
complications (such as firewalls blocking Observer(s) from connecting, etc.).

We recommend running a pilot recording for a short period of time to test
Recorderés start and stop options and
information, see Run a Pilot Test before Recording.

A’ In addition, use the Test Recording option in Recorder to create a 15 second
recording to verify the screen, camera, and audio streams are being recorded

properly.

Verify Network
Settings

If Observer and Recorder are on the same Intranet, you do not need to disable
firewalls.

If they are not, verify that you either disabled any firewalls running on the Recorder
or configured the firewalls to open the communication ports. See your network
administrator for assistance.

There are no firewall adjustments necessary on the Observer side.

Open the study
configuration in
Recorder

Open the saved study configuration in Recorder.
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Run a Pilot Test before Recording

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot
recording helps you work out any network connectivity issues and test your automated start and stop options,
if applicable. Follow these steps to run a pilot test:

Step ‘ Notes
1. Open a study configuration. In Recorder, open the study configuration (.mrcfg) for this study.
Start Recorder. Click the Start button to start Recorder manually.
3. Connect Observers to Connect one or more Observers during the pilot test. Verify that you
Recorder. can successfully connect each to Recorder.
4. Complete a test task. Run through one of the tasks. To test the logging functionality of

Observer, have a team member practice setting markers while you
complete the task.

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button in
Recorder or use the keyboard shortcut <Ctrl + Alt + Shift + F9>,

6. Import the recording and run a Save the test recording file and import it into a project in Manager. In
search. Manager, verify the audio and video recorded correctly. Use the
Search to verify markers were captured. See Analyze and Present

Findings for more information on how to do this.
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Record and Log Test Sessions

In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae
Recorder and Observer. Included in the section are the following:

# Log Tasks on Recorder

Observers and Logging

Start and Stop the Recording

Log the Sessions

Send the Surveys

Save the Recording

¥ ¥V ¥ ¥V V¥

Log Tasks on Recorder

When you record from one or two cameras with Recorder, you can log tasks and notes right on the computer
running Recorder. This is the default task logger setting for camera only recordings.

Observers and Logging

Morae Observer connects to Recorder over a network and displays thefullpart i ci pant 6s experienc
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores,
and text notes that are sent back to the Recorder and saved with the recording file.

Observers

Parfiu'fenf

B

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically
create graphs, calculate marker scores, and more.

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not
see the participant interaction until recording begins.
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Benefits of Observer

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the
following benefits:

g

g

Stakeholders can connect to watch live sessions without the need be in the room with the participant or
an observation room. With Observer, stakeholders can connect from anywhere on the network.

Anyone logged into an Observer computer can add markers during recording complete with text notes.

Mor ae automatically collects and compil es

notes logged by all Observers.
Observer automatically saves and indexes the markers and tasks with the accompanying video and audio

streams.

everyoneods

You can save a copy of the camera video, screen video, and audio streams as a WMV file for immediate
playback or to share with stakeholders.

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to
Recorder.

Start and Stop the Recording

The default way to start and stop recordings is to manually start and stop Recorder using the following
buttons:

@

Start

Stop

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your
equipment and participant set up.

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start
Settings and Define Recording Details > Recording Stop Settings.

Log the Sessions

Once recording starts, the facilitator prompts the participant to begin the test.

The person working on the computer running Recorder along with each person using Observer can log
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder
is designated as the task logger logs tasks and task scores.

With both Recorder and Observer, you can save a copy of your markers and notes. Observers can also save
a copy of the recording as a WMV file for immediate viewing.

e

—at - P

et

N W SR e N L etk R ot S SRl L ERRCARWEIE L pm e oo
Survey: Survey v | Send Survey | =3
= Note Marker T Score Task Time
(D rosearse) | @ erdrekianin | we
L B Task wes suxccessfl Task | 00028
Logas: |Task3 v B roskwes sxcessfd Tazk 1 00042
Task 3 00048
- - o Restart | @ Mo sad he this was very confusing, Q-Quotajcomment Tack 00141
- 1 ,41 Q© Coel Q[mwgt_ufgg_m _ W-User reeds help Task 3 ol
Recordrg time = 000C-30 Task: Task 3 Task ogger: Tiany L) Connection J Recordeg
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At the end of a session, the tasks and task scores are saved with the recording. You can view the
synchronized video, audio, and notes for each marker later when you import the recording into Manager.

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager.
There should be no need to review entire recordi
features to quickly analyze the recordings.

The components used when logging in Recorder and Observer are:

Marker Definitions
Click a Marker Type to

Viewing Window
View main camera video.

PiP Window
View session PiP video.
Hear participant
thoughts and comments.

— i)

0 = 9 e 1375 o

Logas: Tasa % i:“‘wvml & 2 e
=)

00:01:18 &=" Log

Log markers and take notes. Log
task start and end, if applicable.

[Rocorang tane = 00.0714

For more information, in Morae Observer Help, see Log a Session.
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Send the Surveys

Open surveys on the computer running Recorder anytime during the session. When the surveys open, you

can ask the participants the questions and fill out the surveys, let the participant fill out the surveys on the

computer running Recorder, or use the Morae Add-In for Word to print the surveys for the participant to fill in

on paper.
The person logging on the computer running Recorder and all Observers can access and deliver surveys.

# In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>.
# In Recorder or Observer, select and open surveys from the log.

Survey: Task 2 Completion Survey Y\

Task 1 Completion Survey (done] .
m L Task 2 Completion Surve 5

Task 3 Completion Survey

Save the Recording

By default, when recording stops, you are prompted for file details. Enter a name and description for the
recording. If you want to start another recording right away, in Recording Details, choose to defer the
processing of the recording. You can later batch process recordings.

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details >
Processing.

V' You cannot save a recording without a name. You can lose the data from a recording if the test
participant, or anyone else, closes the dialog prompting for these details after the recording stops.

Analyze and Present Findings

In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and

create presentation materials for the test findings.

Included in the section are the following:
1. Import Recordings
2. Edit Recordings

3. Analyze Recordings

4. Graph
5. Create Highlight Clips

6. Create a Report
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1. Import Recordings

To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the
recordings and studies in Manager.

You can have multiple studies in a single project. The following are possible reasons to have multiple studies
in a single Morae project:

#  You conduct the same test on different iterations of a product.
#  You conduct various tests on the same product.
B You want to separate your studies by the experience level of participants.

You can import a single recording into multiple projects. When you import a recording into a project, the
original recording is not touched. A copy of the recording in imported into the project. Any changes you make
to this copy do not affect the original recording.

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf)
into a project.

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create
and Modify a Project > Create a New Project.

2. Edit Recordings

View and edit the imported recordings in the Analyze Tab. In Manager :

v

Review the main camera video automatically synchronized with the Picture-in-Picture video and audio.
B  Create additional or edit the logged tasks, markers, notes, and scores.

B Search across recordings in a study for specific markers..

B  View and edit survey answers.

For information, in the Morae Manager Help, see Analyze.

3. Analyze Recordings

For information on what kinds of things to look for in the recordings, see How to Retrieve Your Key
Measures from Morae.

Managerd Search allows you to quickly create custom searches to look for markers and tasks.

You can use the pre-defined search profiles, define a new search, or create and save your own search
profiles.
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06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc

Search for:

[[] Screen Text

] window/Dialog Events
Markers (Specific markers of mark... ([ Modfi 2]
] Mouse Clicks 7 }
] uservue Chat

(7] Keystrokes

[C] web Page Changes

Y
In all applications ol Markers

Search for markers that meet the following criteria.
O Al markers

(%) Specific markers
[V] Marker type

[] E-End task ~ | Select Al ]
Clear Al

[¥] H- User nesds help

[7] © - Observation 3
[[] e - Participant prompted

[J Q- Quotejcomment

[[] s-start task

DV-%OCb v

[V]Marker score

[] score not set | Select Al ]
Severe (0)
] Medum (1) |  Clear Al l

Click to save the current search as
a profile.

Click to change the search.

~Search profile : ~View —
[Custom search v jH‘ lm ’
/  Elapsed ... Recording Task Event Details Notes Score

0:02:02.08 Participant 2 Marker H (User needs help)  Issues with the phone locki... 2 - Minor
0:03:12.00 Participant 1 Task2 Marker  H(User needs help) Requests help from faciltat... 1 - Medium
0:03:28.15 Participant 3 Task2  Marker H (User needs help)  Locked out of phone 0 - Severe
0:03:28.15 Participant 3 Task2  Marker H (User needs help)  Runs into trouble with the .., Score not set
0:04:47.32 Participant 2 Marker H {User needs help)  Can't figure out the setting...

2 = Minor
0:05:26.14 Participant 1 Task3  Marker H (User needs help) Wants to call customer sup... 1 - Medium
0:07:32.06 Paﬁl:i Task4  Marker H (User needs help)  Can't figure out menus, As... 1 - Medium

< Results include all occurances
Total Even from all recordings in the study. Selected Duration: Not applicable

For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings.
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4. Graph Data, Tasks, Markers, and Surveys

Instead of manually calculating data and building graphs, Morae creates graphs to help you share results
faster, without manual calculations and scrubbing of data.

Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight
videos. Highlight videos can be more powerful with graphs included to support the video clips.

Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format
(CIF) standard i effectiveness, efficiency, and satisfaction:

B Measure effectiveness with error rate and completion rate graphs

B  Measure efficiency with a time on task graph

B Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to

participants at the end of the recording
Example Uses of Graphs

Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why
you might want to use these graphs.

SUS Survey Use this graph to measure satisfaction from a
Graph ' e System Usability Scale (SUS) survey.
f@"‘uﬁ SUS scores can range from 0 (very little
\ 'C satisfaction) to 100 (very high satisfaction).
Survey SUS Survey
Analysis Calculation
Time on Task Use this graph to measure efficiency.
Graph Efficiency is usually measured by determining how
quickly participants are able to complete scenarios
or tasks.

Participants may be able to successfully complete
an activity, but they take a long time.

Task Analysis | Time on Task

Task Score Use this graph to measure effectiveness by
Graph reviewing the completion rates for tasks.
Effectiveness is a way of trying to understand
better how successfully users will be able to use a
site or software. This is usually measured by
determining how many scenarios or tasks
participants are able to complete.

Task Analysis | Task Score

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph >
Graph Analysis Examples.
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